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About i-access Kiosk
The i-access Kiosk software (Kiosk) allows you to download titles from your Vision Australia Library online Bookshelf to your Envoy Connect player or computer.
To use Kiosk you have to be a registered member of the Vision Australia Library and have a Username and Password.
If you are not a member, please contact the Vision Australia Library on 1300 654 656, or email: library@visionaustralia.org
i-access Kiosk is designed for Microsoft Windows 10 or newer.
For Kiosk to work, the computer must be connected to the internet.
[bookmark: _Toc145696093][bookmark: _Toc18311445][bookmark: _Toc18316744][bookmark: _Toc19278059]How to Install
There are two methods of installing the Kiosk software:
· Directly from the Envoy Connect player.
· Downloading from Vision Australia.
[bookmark: _Toc145696094]Installing from the Player
The i-access Kiosk software can be found in the SYSTEM folder on the Envoy Connect player.  The installation file is called KioskSetup.exe.
To install the software, ensure the player is switched off, then plug it into the computer using the supplied USB data cable.  The player will emit a chime to confirm the connection.
Note that Windows File Explorer may open automatically when you connect the player.
The player is called CONNECT in File Explorer.  Open this to select and view the SYSTEM folder on the player.
Within the SYSTEM folder, there is a folder called ‘i-access Kiosk’.  The Kiosk software is in this folder.
Select the ‘KioskSetup.exe’ file to begin installation.
During installation, you may be presented with a ‘Microsoft Windows Security’ message asking if you want to install the software.  Select the ‘Install’ button. 
An ‘i-access Kiosk’ shortcut (icon) will be placed on your desktop when the installation is finished.
[bookmark: _Toc145696095]Installing from the Website
The i-access Kiosk software can be downloaded from: http://softwareupdate.i-accessonline.visionaustralia.org/iaccesskiosk/KioskSetup.exe 
Once the Kiosk software has finished downloading to the Downloads folder on your computer, select the ‘KioskSetup.exe’ file to begin installation.
During installation, you may be presented with a ‘Microsoft Windows Security’ message asking if you want to install the software.  Select the ‘Install’ button. 
An ‘i-access Kiosk’ shortcut (icon) will be placed on your desktop when the installation is finished.
[bookmark: _Toc145696096]Before you Begin…
You can choose between two types of devices to use with the Kiosk software:
· Envoy Connect Player - Download to an Envoy Connect player.
· Local Computer - Download to the Computer.
Note that when you run Kiosk, the title bar displays the current device type (Envoy Connect or Local Computer).
[bookmark: _Toc145696097]How to Use - Envoy Connect Manual Mode
Envoy Connect Manual mode is the default mode.  It allows you to choose titles to remove from the Envoy Connect player and choose new titles to download from your online Library Bookshelf onto the player.
[bookmark: _Toc145696098]Plug In the Player
Ensure your player is switched off, then connect it to the computer using the supplied USB data cable.  The player will emit a chime to confirm the connection.
Note that if Kiosk is running before plugging in the player, it will prompt you to plug it in.
[bookmark: _Toc145696099]Open i-access Kiosk
To run i-access Kiosk, select the i-access Kiosk icon on your computer desktop.
When you first run Kiosk a ‘Getting Started’ guide will appear.
You can choose not to display the Getting Started guide when you run Kiosk by deselecting the ‘Show next time on Startup’ checkbox.  You can access Getting Started and this User Guide at any time from the Help menu.
Select the ‘Close’ button to proceed.
A message will confirm that a player is plugged in.
Select the ‘Continue’ button to proceed or the ‘Cancel’ button to return to the main screen.
To login to the Library from the main screen, select the 'Connect to Library' button.
[bookmark: _Toc145696100]Login
If your player is registered with the Library, the player will be recognised by the system and login automatically.
If your player is not registered, you will be prompted to enter your Library Username and Password.
‘Tick’ the ‘Save Username/Password’ checkbox to avoid entering it each time.  If your login fails for any reason, the login screen re-appears.
Select the ‘OK’ button to proceed.
Kiosk will connect to your Vision Australia online Library account.
Note that logging in may take a few minutes depending on the size of your online Bookshelf and the speed of your internet connection.  Do not unplug your player.
[bookmark: _Toc145696101][bookmark: _Toc19278061]Messages from Library
If there is a message from the Library, a ‘popup’ screen will appear during login.  Select the ‘Close’ button to retain the message or select the ‘Delete’ button if you do not wish to read it again.
[bookmark: _Toc145696102]Connection Status
When logging in to the Library and downloading, a status field shows the progress.  This screen also shows the Username and the player serial number.
Select the ‘Cancel’ button if you want to stop the process at any time and return to the main screen.
Note that if you cancel downloading, only those titles that have completed downloading will be playable on the player.  When you next run Kiosk, you will need to re-select the uncompleted titles from your Bookshelf to resume downloading them.
[bookmark: _Toc145696103]Select Titles to Remove
Once Kiosk has logged on, it will display the ‘Select Titles to Remove’ screen.  This is the list of titles on your Envoy Connect player.
Select one or more titles from the list to remove them from your player.  This will also remove them from your online Bookshelf.
Removing titles will allow more titles to be added to your online Bookshelf to replace those that you remove.
You can also use the ‘Select All’ or ‘Deselect All’ buttons.
Note that you do not need to remove any titles, however, eventually the memory on the player will become full preventing you from downloading more titles.
Select the ‘Next’ button to proceed.
[bookmark: _Toc145696104]Select Titles to Download
Kiosk will display the ‘Select Titles to Download’ screen.  This is the list of titles on your online Library Bookshelf that you can download.
Select one or more titles from the list to download to your player.
You can also use the ‘Select All’ or ‘Deselect All’ buttons.
Note that if this Bookshelf list is empty, your new titles are being prepared in the background.  Populating your Bookshelf may take up to an hour.  Continue to the next step and check the list again later.
Select the ‘Next’ button to proceed, or the ‘Back’ button to return to the previous screen.
[bookmark: _Toc145696105][bookmark: _Toc18311450][bookmark: _Toc18316749][bookmark: _Toc19278071]Confirm Content Update
Kiosk will ask you to confirm the selections you have made in the previous screens.
Select the ‘Next’ button to proceed with the content update (removing and downloading).
If you wish to review or change your selections, select the ‘Back’ button. 
Note that if you use the ‘Back’ button you will need to reselect any titles you had previously selected.
You can select the ‘Cancel’ button if you want to ignore all previous steps and return to the main screen.
Note that downloading content onto your player may take some time depending on how many titles you have selected and the speed of your internet connection.
The Status field will keep you informed of progress once the downloading of content commences.
Do not disconnect the player or exit the program until Kiosk confirms “Your content has been updated”.
[bookmark: _Toc145696106]Player Update Completed
A popup screen with a ‘Content Updated’ confirmation message will be displayed once the download of content has finished.
Select the ‘Eject Player’ button.  This is the same as using the Windows USB eject feature.  It is now safe to disconnect your player.
Select the ‘OK’ button to return to the main screen of Kiosk.  Select the ‘Exit’ button to close the Kiosk software.
[bookmark: _Toc145696107]How to Use - Local Computer Device Type
The instructions for Local Computer mode are the same as Envoy Connect Manual mode, except that the content is downloaded to your local computer instead of to the Envoy Connect.
To select this mode, go to the File Menu (see File Menu section below).
The first time you select this mode an ‘i-access Kiosk Content’ shortcut (icon) will appear on your desktop.  This is the default location for titles that are downloaded to your computer.
[bookmark: _Toc145696108]How to Use - Envoy Connect Automatic Mode
Important Note: Only use Automatic mode after you understand how it works as described below.
Envoy Connect Automatic mode always removes all content from your Library Bookshelf as well as from your player.  It also downloads all of the new titles from your Bookshelf onto the player without user input or confirmation.
Be sure you wish to always automatically remove all content from both your player and from your Bookshelf before selecting this mode.
To select this option, go to the File Menu (see File Menu section below).
[bookmark: _Toc145696109]Login
The instructions for logging on and monitoring progress are the same as Manual mode.
[bookmark: _Toc145696110]Removing All Titles
In Automatic mode, as soon as you log in, all content is immediately removed from the player and also from your online Bookshelf.
Once all titles are removed, new titles will be added to your online Bookshelf in the background.  Note that populating your Bookshelf may take up to an hour.
Kiosk will ask you to wait before continuing.  Select the ‘OK’ button to return to the main screen of Kiosk while you wait.
Note that if this is the first time you are connecting a new player, there will be no titles on the player to remove.  Kiosk will immediately begin to download the current Bookshelf.
[bookmark: _Toc145696111]Downloading All New Titles
After waiting for up to an hour for the Bookshelf to be populated, run Kiosk with the player plugged in.
Downloading will begin automatically and the Status field will keep you informed of progress.
Do not select the ‘Cancel’ button, disconnect the player or exit the program until Kiosk confirms “Your content has been updated”.  Interrupting the download will result in the removal of titles that have only partially downloaded and Kiosk cannot re-download them.
When the popup screen with the ‘Content Updated’ confirmation message appears, select the ‘Eject Player’ button.  This is the same as using the Windows USB eject feature.  It is now safe to disconnect your player.
Select the ‘OK’ button to return to the main screen of Kiosk.  Select the ‘Exit’ button to close the Kiosk software.
[bookmark: _Toc145696112]Using Two Players
In Automatic mode, a new list of titles is generated on the Bookshelf every time a player is connected.  This allows a person to use two Envoy Connect players, each with a different list of titles.
For example, a user can listen to one player while a family member or friend is loading the second player.
[bookmark: _Toc145696113]i-access Kiosk Content Folder
This is the default location where all downloaded titles are saved in Local Computer mode.
Note that depending on your computer settings, this folder may contain a file called ‘_Bookshelf.xml’.  Do not move or delete it.  Doing so may affect the content update process.
[bookmark: _Toc145696114]Main Screen
This screen allows you to connect to the Library and start the content download process.  It also provides access to your ‘MyVA’ website, desktop content folder, as well as the File and Help menus.
Select the 'Connect to Library' button to connect to the Vision Australia Library, view your online Bookshelf and update content on your player or computer.
Select the ‘My VA Website’ button to access your Library account.  The website will open in a separate screen.  Using the MyVA website, you can set user preferences as well as search and add titles to your Bookshelf.
Select the ‘Exit’ button to close the Kiosk software.
Note that the Kiosk title bar displays the current mode (Envoy Connect or Local Computer).
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[bookmark: _Toc145696116]Options (Settings)
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You can choose between two types of devices.
· Envoy Connect Player
· Local Computer
[bookmark: _Toc145696118]Envoy Connect Player
Select this option to download from your online Library Bookshelf onto your Envoy Connect player.
This is the default option when you install Kiosk.
[bookmark: _Toc145696119]Local Computer
Select this option to download from your online Library Bookshelf onto your computer.
[bookmark: _Toc145696120]Player Loading Mode
There are two loading modes when you choose to load to an Envoy Connect player.
· Manual
· Automatic
[bookmark: _Toc145696121]Manual
This option allows you to choose new titles to download from your Library Bookshelf onto your player, and titles you would like to remove from the player.
[bookmark: _Toc145696122]Automatic
This option automatically updates the player without any user input or confirmation.
It immediately removes all titles from the player and online Library Bookshelf, generates a new list of titles and downloads all new titles from your Bookshelf onto the player.
Automatic mode allows use of two Envoy Connect players, each with a different list of titles.
Use this mode with caution.  Any time you connect your player, all content will be removed from both your player and your online Bookshelf.  Kiosk cannot re-download titles once they are removed.
[bookmark: _Toc145696123]Show ‘Getting Started’ on Startup
You can choose to display or not display the Getting Started guide each time you run Kiosk by selecting the ‘Show Getting Started on Startup’ checkbox.
[bookmark: _Toc145696124]Clear Saved Username and Password
If you previously chose to save your username and password when logging in, you can select the ‘Clear Saved Username and Password’ button to be prompted to enter them again when you next run Kiosk.
This is useful if your Kiosk is to be used by someone else to prevent them logging into your account.
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The ‘Use default location in Local Computer mode’ checkbox is selected by default.  This saves downloaded titles to the ‘i-access Kiosk Content’ folder on your computer desktop.
You can choose a different location by ‘unticking’ the checkbox and selecting ‘Browse’.  This opens a ‘Browse’ screen where you can choose a different location or create a new folder by using the ‘Make New Folder’ button.  Select the ‘OK’ button to save your preferred location.  Select the 'Cancel’ button to return to the Options menu without saving your changes.
The ‘Content Location’ field displays the file path.
Note: when choosing a different folder location, be sure not to choose the CONNECT drive.  This drive is the Envoy Connect player.
[bookmark: _Toc145696126]Exit the Options Menu
After you set your preferences, select the ‘OK’ button to save your changes and return to the main screen.
Note that Kiosk will remember the currently selected settings each time you run the software.
Select the ‘Cancel’ button to return to the main screen without saving your changes.
[bookmark: _Toc145696127]Open Content Location
This opens the ‘i-access Kiosk Content’ folder from your desktop in a separate File Explorer window.
Within this folder there is another folder called Downloads.  This is where all downloaded titles are saved in Local Computer mode.
Note that this menu item is only visible if you are using Local Computer Mode.
[bookmark: _Toc145696128]‘MyVA’ Website
This opens the Vision Australia ‘MyVA’ website in a separate screen.  Here you can access your Library account to set user preferences as well as search and add titles to your Bookshelf.
[bookmark: _Toc145696129]Exit
Select Exit to close i-access Kiosk.
[bookmark: _Toc145696130]Help Menu
[bookmark: _Toc145696131]Getting Started
Opens the ‘Getting Started’ guide.
You can choose if the Getting Started guide is displayed when you run Kiosk by selecting or deselecting the ‘Show next time on Startup’ checkbox.
Select the ‘Close’ button to return to the main screen.
[bookmark: _Toc145696132]User Guide
Opens the ‘User Guide’.
Select the ‘Close’ button to return to the main screen.
[bookmark: _Toc145696133]About
Information about i-access Kiosk, including the version number and Vision Australia contact details.
Select the ‘OK’ button to return to the main screen.
[bookmark: _Toc145696134]New Versions of i-access Kiosk
Each time you run i-access Kiosk, it checks if a newer version is available.  If a software update is available, it will automatically update and a progress status screen will momentarily appear.
During installation, you may be presented with a ‘Microsoft Windows Security’ message asking if you want to install the software.  Select the ‘Install’ button.  
When the software update is finished, Kiosk will open as normal.
If a software update has occurred, the ‘Getting Started’ guide will be displayed and describe ‘What’s New’ in the latest version of i-access Kiosk.
[bookmark: _Toc145696135]Contact and Support
If you have any questions or comments, please contact the Vision Australia Library on 1300 654 656 or email: library@visionaustralia.org 
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